
5 basic steps to updating a nutrient 
management plan using SnapPlus
1  Add any new field, crop, soil test, or nutrient information

2  Click on File>Save Snapshot

3  Update crop and nutrient application information for 
multiple years and fields using the Rotation Wizard. If 
you make a mistake, you can select File>Revert to Last 
Snapshot to start again.

4  Run reports

5  Archive your files

fast facts

SnapPlus tillage codes and explanations
SnapPlus uses the most soil-disturbing tillage options available in the RUSLE2 
database for each primary tillage category. If you meet “T” with SnapPlus, then 
you are protecting the field from excess soil erosion. Fall and spring chisel and 
moldboard options listed include secondary tillage.

Code Tillage RUSLE2 operations (assumptions for soil loss calculations)

FCD
3-pass

Fall chisel, 
disked

Fall chisel plowing (twisted shovel) with spring disking (tan-
dem) and field cultivation before planting. 

FCND
2-pass

Fall chisel, 
no disk

Fall chisel plowing (twisted shovel) and field cultivation before 
planting.

FP
3-pass

Fall 
moldboard plow

Fall moldboard plowing with spring disking (tandem) and field 
cultivation before planting.

FVT
2-pass

Fall vertical 
tillage

Fall pass plus a spring pass with same seedbed conditioner: 
double gang coulter caddy, rotary harrow, and rolling basket 
incorporator.

NT No-till No soil disturbance except for planter using a double-disk 
opener and fluted coulter. 

SCD
3-pass

Spring chisel, 
disked

Spring chisel plowing (twisted shovel) followed by disking 
(tandem) and field cultivation before planting.

SCND
2-pass

Spring chisel,  
no disk

Spring chisel plowing (twisted shovel) and field cultivation 
before planting.

SFC
1-pass

Spring 
cultivation

One field cultivation before planting, use for most 1-pass 
systems.

SP
3-pass

Spring 
moldboard plow

Spring moldboard plowing followed by disking (tandem) and 
field cultivation before planting.

ST Strip-till No soil disturbance except for 30% of the surface at planting 
with a strip-till planter.

SVT
1-pass

Spring vertical 
tillage

Spring pass using a seedbed conditioner with a double gang 
coulter caddy, rotary harrow, and rolling basket incorporator.

SnapPlus Tip:  Tillages should be entered by cropping year, not calendar 
year (see the glossary for full explanation).

SnapPlus Tip:  For the fastest 
response to SnapPlus questions: 
email support@snapplus.wisc.edu

1  Run the Compliance Report for the plan year and rotation. 

2  If problems are listed for the plan year and rotation, first go back and 
check that the information entered for the fields and years is correct 
(problems listed for previous years do not need to be addressed). 
Then review the following sections for suggestions to common 
problems. When making adjustments to reach compliance, be sure 
that the solutions can be implemented. 

3  For more help with specific compliance issues, consult the 
resources listed below and/or contact DATCP or your local land 
conservation department (LCD).

View SnapPlus tutorial videos at snapplus.wisc.edu      View NPM publications & videos at ipcm.wisc.edu 
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8 basic steps to developing a new nutrient 
management plan using SnapPlus
1  Install SnapPlus version 2.0

2  Create a new farm

3  Import your farm’s soil tests

4  Enter field information

5  Enter nutrient sources

6  Enter crop and nutrient application information

7  Run reports

8  Archive your files

Save Snapshot allows you 
to save the database at a 
specific point in time. This 
gives you the option to revert 
the file back to that point 
during a session if needed. 
You can save multiple 
snapshots.

Archive saves a zipped database with a time-stamp 
appended to the name. Recommended for saving a 
database for historical/reporting purposes.

SnapPlus Tip: Selecting a P strategy

1  If soil test P levels are already below 50 ppm, select Soil Test P to 
maintain P levels at their current state. 

2  If soil test P levels are at or above 50 ppm, select  
P Index to allow for higher P applications on crops as long as there is no 
risk for P loss on the field. 

3  Select both to ensure optimum P levels and lower environmental risk.

P-RELATED RESTRICTIONS:  If soil tests are in the non-responsive range, then 
do not apply commercial P fertilizer with the exception of 20 lb of P2O5 in a starter fertilizer. 
When applying manure in winter, do not exceed the next year’s crop P removal. These 
problems will cause orange highlights in This year’s manure or This year’s fertilizer.

MANURE-RELATED RESTRICTIONS:  To address most problems, move 
applications during times of the year with increased run-off or leaching potential to 
different fields and/or reduce or eliminate applications. For fields in SWQMAs, move winter 
manure applications to summer, spring, or fall. If not possible, then spread at least 300 ft 
from streams/rivers and1,000 ft from lakes/ponds.  These problems will cause orange 
highlights in This year’s manure or This year’s fertilizer.

N-RELATED RESTRICTIONS:  For most problems, reduce manure or fertilizer 
applications for the field. If it is an N restricted soil, do not apply commercial N fertilizer 
in the fall, including any N that is part of a P or S-related fertilizer (i.e. DAP). See Excessive 
Nitrogen Applications on page 2 for more information. These problems will cause red 
highlights in This year’s manure or This year’s fertilizer cells.

GROUNDWATER RESTRICTIONS:  Manure and fertilizer (N and P) cannot 
be spread without incorporation within 200 ft upslope of a conduit to groundwater 
(incorporated or sub-surface applications are acceptable).  For residential wells, manure 
cannot be spread within 50 ft. Move these manure applications to different fields. These 
problems will cause orange highlights in This year’s manure or This year’s fertilizer.

ROTATIONAL RESTRICTIONS:  If rotational soil loss it too high, make 
adjustments in the future to reduce soil disturbance and increase residue or year-round 
cover (i.e. reduce tillage, leave fodder on field, use cover and nurse crops, add grasses to 
alfalfa mix, move silage around to different fields). If rotational PI is too high, look at the 
annual PI rows at the bottom of the cropping screen or in the Annual PI report. If particulate 
P is high, then reduce soil loss using strategies listed above. If soluble P is high, then avoid 
winter manure applications, reduce application rates, or incorporate manure. 

Finding and fixing 590 issues in SnapPlus  Issue list is for non WPDES-permitted farms (CAFOs). CAFOs have more compliance issues that are not listed in this publication.

SnapPlus Tip:  If you save an archived .snapDB files 
on your PC and send it as an email attachment, the 
data in the file cannot be altered in any way.  
It is read-only.

COMPLIANCE REPORT ANATOMY

ROTATIONAL RESTRICTION PROBLEMS: 

yy Rotational P2O5 balance target is exceeded (only applies to Soil Test P method)

yy Rotational soil loss is too high
yy Rotational average PI is too high (rotational PI cannot exceed 6)

MISSING INPUTS: Summarizes any missing inputs that are needed to run the report.

SOIL TEST PROBLEMS: 

yy Soil test sample density has too few samples (<1 sample per five acres)

yy Soil test data is too old (soil test results for plan year need to be< 4 years old)

APPLICATION RESTRICTIONS: Application restrictions are listed by field and year. 

yy Overapplication of manure or fertilizer N
yy No winter spreading on slopes steeper than 12% or on uncon-
toured slopes between 9 and 12% (make sure you check Contouring in the Rotation 
Summary if applicable)

yy Local restrictions may prohibit winter spreading  
(local prohibitions for winter applications box is checked in Field Restrictions dialog box)

yy Winter spreading rate must be less than 7,000 gallons/acre
yy Planned rate is too high for single, unincorporated liquid manure 
application in SWQMA

yy Planned unincorporated application in SWQMA is not likely to 
have 30% canopy cover or residue for runoff reduction, and no 
filter strips or cover crops are planned

yy Winter applications prohibited within SWQMA
yy One or more applications are not compatible with None or No till 
selected (this is not actually a restriction, but shows up as a warning)

yy Winter manure P2O5 applications exceed this year’s crop removal
yy Annual PI > 12 (annual PI cannot exceed 12)

yy Excess fertilizer P2O5. More than the entire P2O5 recommendation 
for the planned rotation on this field has already been applied as 
manure or fertilizer 

yy Overapplication of manure or fertilizer N
yy No fall fertilizer N can be applied to this crop on soils with a high 
N-leaching potential

yy This field has fall or late summer N applications in excess of what is 
allowed for soils with a high N-leaching potential

yy Farms are not allowed to apply manure within 50 feet of  
a drinking water well

yy Unincorporated or grazing applications upslope of conduits to 
groundwater: sinkhole, fractured bedrock, tile inlet, well within 
200 feet, or other conduit

EXCESS N: Summarizes any excessive N applications by field and year. 
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Nutrient management glossary
590 restrictions:  Nutrient application restrictions from the 590 standard, which include 
winter spreading, surface water quality management area (SWQMA), fall nitrogen application, 
set-backs from conduits to groundwater, and other restrictions. 

Adjusted UW recommendations:  P2O5 and K2O recommended by University of 
Wisconsin for that crop and soil test minus the P2O5 and K2O carryover since the last soil test.

Concentrated flow channel: Areas within or on field edges where water flow chan-
nelizes and can erode soil.

Cropping year:  For a field, the new cropping year starts after the previous crop has 
been harvested and spans the time to the next harvest. For example, if a winter wheat field is 
harvested in July 2013 and manure is applied following the harvest, then the manure applica-
tion would be included in the 2014 cropping year (same for any fertilizer applications or tillage 
following harvest).

harvest harvesttillage and nutrient app planting

CROPPING YEAR

JAN MAY SEPSEP FEB JUN OCTOCT MAR JUL NOVNOV APR AUG DECDEC

Note: This example shows single crops with general harvesting/planting dates. See A Guide 
to SnapPlus crop abbreviations for more variations on crops combinations.

Dominant critical soil:  The most erodible soil type that covers at least 10% of the 
field. Used to determine soil loss and the P Index in SnapPlus.

Field “T”:  Tolerable soil loss (the amount the field can lose in tons/acre/year) as determined by soil 
type.

Filter areas:   A grass strip within a field or an area on the edge of a field designed to 
capture sediment in runoff. These selections in SnapPlus assume there are no concentrated 
flow channels through the grass filters.

N restricted soil:   Soils that have the potential for nitrate leaching to ground water. 
Definition of symbols: (P) High permeability soils, (R) Less than 20 inches to bedrock, (W) Less 
than 12 inches to apparent water table, (+) This map unit may have any of the N restrictive 
features, however an on-site investigation is needed to identify which restrictions may actu-
ally be present.

On-contour:  A field that is consistently planted and tilled on the contour across the slope.

P Index:  The Wisconsin Phosphorus Index, a planning tool used to rank fields by runoff P loss 
potential. Annual total PI is calculated by estimating the average annual runoff P delivery from 
a field to surface water. Particulate PI is an estimate of P delivered with eroded sediment, and 
Soluble PI is an estimate of dissolved P delivered from soil and nutrient applications.

Spread method:  Unincorporated—broadcast on surface with more than 72 hours 
before tillage; Incorporated—surface-applied and incorporated into soil by tillage or infil-
tration; Injected (manure)—injected below soil surface or incorporated by tillage within 1 
hour; SubSurface (fertilizer)—applied below the soil surface; Grazing (manure)—depos-
ited directly from the animal.

Soil condition Index (SCI): A positive number indicates soil organic matter is likely 
increasing across the rotation, while a negative number indicates it is likely to be decreasing.

Strip crop: Contour strips of alternating row and hay crops. Assumes at least two strips on 
the field slope length.

SWQMA: A Surface Water Quality Management Area is an area within 300 ft of a perennial 
stream/river or 1,000 ft of a lake/pond.



1 Includes Legume credits, Manure credits, This year’s manure and This year’s fertilizer.  
Note:  If the entire amount shown here is supplied through organic sources, some starter N fertilizer (up to 20 
lb N per acre) can be applied before the SnapPlus warning notices are given.

Csl Corn silage 
Csl18 Corn silage, 18 inch rows 
Cs30 Corn silage, 30 inch rows 
CU Cucumber 
BNd Dry beans 
Fs Direct seeded Legume Forage
FL Flax 
GN Ginseng, established 
GN Ginseng, harvest year 
GN Ginseng, planting year 
GH Grass hay 
GHs Grass hay, seeding 
Gnh Grasslands, permanent, not harvested 
HP Hop 
IL Idle land 
lR Interseeded rye cover
Lsl Legume silage
lcv Legume cover crop, underseeded 
Lcv Legume cover crop, interseeded
LE Lettuce 
LB Lima bean 
ME Melon 
ML Millet 
MT Mint, established 
MT Mint, seeding 
Of Oatlage 
OPf Oat-Pea Forage 
Og Oats 
Og+s Oats grain plus straw 
ON Onion
Psg Pasture seeding, grass 
Psl Pasture seeding, grass/legume 
Psml Pasture seeding, legume more than 30% 
Pu Pasture, continuous stocking, high density 
Pcl Pasture, continuous stocking, low density 
Pdl Pasture, dry lot, exercise area 
Prg Pasture, rotational stocking, grass 
Prl Pasture, rotational stocking, grass/legume 
Prl>30 Pasture, rotational stocking, legume 
more than 30% 
Pg Pasture, variable stocking, managed continu-
ous 
Pl Pasture, variable stocking, managed continu-
ous, grass/legume 
Pl>30 Pasture, variable stocking, managed 
continuous, legume more than 30% 
PF Pea, field 
PE Peas 
GP Pepper 
POe Potatoes, early harvest 
POe+cv Potatoes, early harvest, to small grain 
cover crop 
POl Potatoes, late harvest 
PU Pumpkin 
RA Raspberry 
RAe Raspberry, establishment 

RC Red clover 
RCcv Red clover cover crop, interseeded
RCg Red clover (grassy, yr 3+) 
RCss Red clover, seeding spring 
RC Red clover, fall killed 
SB Snapbean 
SBe10 Snapbean, early plant, less than 10 
inch rows 
SBe30 Snapbean, early plant, 30 inch rows 
SBl10 Snapbean, late plant, < 10 inch rows
SBl30 Snapbean, late plant, 30 inch rows 
SG Small grain
SGsl Small grain, silage 
cvr Small grain, cover
cv Small grain cover crop, not harvested 
SD Sod, established 
SDh Sod, harvest year 
SDs Sod, seeding, fall 
SDs Sod, seeding, spring 
Sf Soybean forage 
SGf Sorghum-sudan forage 
Sg15 Soybean 15-20 inch rows 
Sg30 Soybean 30-36 inch rows
Sg7 Soybean 7-10 inch rows 
SP Spinach 
SQ Squash 
SRg Sorghum, grain
s Straw
s7 Straw 7-10 inch rows
s15 Straw 15-20 inch rows
s30 Straw 30-36 inch rows
ST Strawberry, established 
STp Strawberry, planting 
SU Sunflower 
SC Sweet corn
SCe Sweet corn, early plant (before May 20) 
SCl Sweet corn, late plant (June10 or Later) 
SCm Sweet corn, middle plant (May 20-June 10) 
SW Switchgrass 
SWs Switchgrass, seeding 
T Tobacco 
TM Tomato 
BFT Trefoil, birdsfoot, established 
BFTs Trefoil, birdsfoot, seeding 
TRgs Triticale (winter) grain plus straw 
TRg Triticale (winter), grain 
Wsg Wheat spring 
Wsg+s Wheat spring grain plus straw 
Wwg Wheat winter 
Rwf Winter rye (forage) 
Rwg Winter rye 
SGwsl Winter small grain silage 
TTwf Winter triticale (forage) 
Wwf Winter wheat (forage) 
Wwg Winter wheat (grain)

A Alfalfa 
F Alfalfa (1st cut) to Corn grain 
Ag Alfalfa (grassy, yr 3+) 
Asls Alfalfa seeding fall 
As Alfalfa seeding spring 
Afk Alfalfa, fall killed 
AB Alfalfa/Brome 
ABsls Alfalfa/Brome seeding fall 
ABs Alfalfa/Brome seeding spring 
ABfk Alfalfa/Brome, fall killed 
AG Alfalfa/Grass 
AGsls Alfalfa/Grass seeding fall 
AGs Alfalfa/Grass seeding spring 
AGfk Alfalfa/Grass, fall killed 
acv Annual cover crop 
AP Apple 
APe Apple, establishment 
AS Asparagus, established 
AS Asparagus, planting 
AS Asparagus, year 2 
Bf Barlage to Sorghum-Soybean 

MAXIMUM ALLOWABLE 1ST YEAR MANURE NITROGEN APPLICATION 
RATES FOR LEGUME & (LEGUME + COMPANION) CROPS3

Yield range
Manure N allowed 

(lb/a)1

Alfalfa, alfalfa with brome, red clover, or birdsfoot trefoil; 
established

2.6-3.5 ton 170
>3.6 ton 220

Alfalfa, alfalfa with brome, red clover, or birdsfoot trefoil;
seeding

no harvest 60
1.0-2.5 ton 170
2.6-3.5 ton  220
3.6-4.5 ton 280

Barley with alfalfa, alfalfa with brome, or red clover seeding 25-50 bu 150
51-75 bu 180
76-100 bu  210

Dry beans 10-20 cwt  60
21-30 cwt 100
31-40 cwt  140

Oats with alfalfa, alfalfa with brome, or red clover seeding 30-60 bu  150
61-90 bu  170
91-120 bu  190

Pasture seeding, grass with legume, or legume more than 30% 0.5-1.9 ton  80
Pasture, not-rotational or rotational, grass with legume, or 
legume more than 30%

2-3 ton  110
3.1-4.0 ton  150
4.1-5.0 ton  200

Small grain silage underseeded with alfalfa,  
Small grain and legume silage, or  
Small grain and legume silage underseeded with alfalfa

2-3.5 ton 220

Soybean 15-25 bu  80
26-35 bu  120
36-45 bu  160
46-55 bu  200
56-65 bu  240
66-75 bu  280
76-85 bu  320

3 Some SnapPlus legume crops such as peas and snap beans are not included in this table because N removal 
in the harvested portions of the crop is similar to their N fertilizer recommendation.

SnapPlus Tip:  When creating rotations in the Rotation 
Editor, enter the abbreviations. The full crop names will 
automatically be entered into the table.

MAXIMUM ALLOWABLE NITROGEN APPLICATION FOR CROPS OTHER 
THAN MRTN OR LEGUME CROPS

Maximum N rate ( N lb/a)1

All N from manure/legume credits  1.2x UW recs

Commercial N UW recs

Excess nitrogen applications (No flag will occur until >9 lb N/a over the maximum allowable amount)

MAXIMUM ALLOWABLE NITROGEN APPLICATION FOR CORN

The maximum allowable N rate for corn is set at the high end of the range for the 0.05 Corn: 
N price ratio. These are the highest N rates in the UW-Extension guidelines and are recom-
mended where manure and legume credits provide all the corn crop’s nitrogen needs.

Soil group: Yield Potential
Previous crop Maximum N rate (lb/a)1

Loamy: High yield potential soils
Corn, forage legumes, legume vegetable, or green manures 210
Soybean or small grains 160
Loamy: Medium yield potential soils
Corn, forage legumes, legume vegetable, or green manures 160
Soybean or small grains 150

Sands/loamy sands
All crops-irrigated 230
All crops-not irrigated 150

Soil group: Yield potential

MAXIMUM ALLOWABLE NITROGEN APPLICATION FOR WHEAT

Soil group
Previous crop

Maximum N rate ( N lb/a)1 

Winter wheat Spring wheat

Loamy2

Corn, forage legumes, legume 
vegetable, or green manures

 85 75

Soybean or small grains 65 55

Sandy (sands/loamy sands)-All crops 115 105

Organic-All crops 0 0
2 Soils in the loamy group that have less than 2% organic matter (OM) use the sandy group maximum  
allowable N rate. Loamy soils with greater than 10% OM have maximum allowable N rates that are 30 lb N 
per acre lower than those shown in the table.

Soil group

SnapPlus crops are based on a crop year that generally runs from the 
day after the fall harvest to the next fall’s harvest, with some variation 
for crops that do not fit this schedule. When two crops are planted or 
harvested in a single crop year, it is a double crop. If one of the crops 
grown is not harvested, then it is a cover crop. If an annual crop is 
used to assist in the establishment of a perennial crop, it is a nurse 
crop.  Below is the syntax used in the different cropping systems. 
Note that these combinations must already exist in SnapPlus.  A full 
list of available cropping systems is listed on the Farm Screen.

yy double crops use brackets and a dash: [F-Sg]

yy cover crops (or straw) use a plus sign: Csl+cv

yy nurse crops and perennial crops are typed together: BfAs

yy the syntax can be combined (i.e. [PE-CU]+cv)

Changes to make Rotation Wizard selection

Crop, yields or tillage

Change existing … >Cropping dataLegume stand information for N credits

Add season notes

Add/delete manure or fertilizer application Change existing… >Application
Remove a single manure or fertilizer application
Note: Enter application information and set rate to 0. Change existing>Application>Edit existing 
Spread method or rate for a planned application

Delete crop years Delete crop and application data… 
Contouring or filter strips

Edit rotational settings for fields
Rotation length and start year

Price ratio or range point for MRTN crop N recs Edit MRTN data for fields

Speedy ways to update and fine-tune crop management information:

Bg Barley 
BT Beets table 
BL Blueberry 
BLe Blueberry, establishment 
BF Brassica forage 
BR Broccoli 
BRU Brussels sprouts 
BU Buckwheat 
CRP CRP 
CB Cabbage 
CN Canola 
CR Carrots 
CA Cauliflower 
CE Celery 
CH Cherry 
CHe Cherry, establishment 
Cg Corn grain 
Cg18 Corn grain, 18 inch rows 
Cg18bs Corn grain, 18 inch rows, baled stalks 
Cgbs Corn grain, baled stalks 
Cp Corn popcorn 

Nutrient Management Resources:

Groups can be used to logically 
organize fields by any means that 
might be useful. Fields may be in 
more than one group. Groups can 
also be used to reduce the number 
of fields displayed on the Fields tab 
or in the Rotation Wizard. 

Sub-farms can be used to 
identify fields that are lo-
cated together geographi-
cally, fields that share the 
same manure sources, or 
rented fields with the same 
owner. Fields may only be 
in one sub-farm.

SnapPlus Tip:  To record liming info, go to the Cropping 
Screen>Click on a cell in Lime Rec row.

NPM Understanding Soil Phosphorus  
(http://ipcm.wisc.edu/download/pubsNM/UnderstandingSoilP04.pdf)

NPM Nutrient Management Fast Facts  
(http://ipcm.wisc.edu/download/pubsNM/NutrientManagementFastFacts.pdf)

NPM Management Options for Farms with High Soil Test Phosphorus 
Levels  
(http://ipcm.wisc.edu/download/pubsNM/PMngmtOpt.pdf)

UWEX A2809 Nutrient Application Guidelines for Field, Vegetable, and 
Fruit Crops in Wisconsin  
(http://learningstore.uwex.edu/assets/pdfs/A2809.pdf )

SnapPlus Tip:  To adjust UW recs to reflect current soil nitrate 
test results, go to the Cropping Screen and click on a cell in 
the UW Recommendation row to open the Nutrient Recom-
mendation Details dialog box. Click on the cell in the Adjust-
ment row to record the new data.

SnapPlus Tip:  The Grazing herd estimator can be opened 
by clicking on the Grazing Est. button, which is located on 
the Grazing Herd Setup tab (Nutrients Screen) or the Nutrient 
Application Planner.  To open the planner, clicking on any cell 
in This year’s manure or This year’s fertilizer (Cropping Screen).

A guide to SnapPlus crop abbreviations

View>Nutrient Applications by Season to find out if the plan distributes all manure 
when it is available, so storage capacities will not be exceeded.

Fields>Groups to designate a group of fields that need the same updates. Groups can 
be selected in the Rotation Wizard.

Daily Log to update planned manure applications with actual application rates used.

Tool>Rotation Wizard to make changes across multiple fields and/or crop years. 


